# Table of Contents

## About this Guide
1. Useful Tips ................................................................. 4
2. About the MILL Module .................................................. 4
3. Using this Guide ............................................................ 5

## Getting Ready
1. Running VisualCAM 2018 ............................................. 6
2. About the VisualCAM Display ......................................... 6
3. Launch the MILL Module .................................................. 7
4. Load the Part Model ....................................................... 11
5. Machining Strategy ......................................................... 13
6. Main Programming Steps ............................................... 13
7. Define the Machine Tool .................................................. 14
8. Select the Post Processor ................................................ 15

## The Setup
1. Define the Machining Setup - Skip this section if in Standard or Expert Configuration ........................................... 19
2. Create Stock Geometry .................................................... 19
3. Align Part and Stock ....................................................... 23
4. Specify Material ............................................................. 25
5. Set Work Zero ............................................................... 27

## Create Tools

## Machine the Inner Profiles
1. Machining Features/Regions ........................................... 38
2. Cutting Tool ............................................................... 40
3. Feeds and Speeds ........................................................ 41
4. Clearance Parameters .................................................... 42
5. Cut Parameters ............................................................. 44
6. Cut Level Parameters ..................................................... 45
7. Entry/Exit Parameters .................................................... 46
8. Cut Material Simulation .................................................. 49

## Machine the Outer Profile

© MecSoft Corporation
Post G-Code

Generate Reports

1. Information Report

2. Shop Documentation

Where to go for more help

Index
About this Guide

1.1 Useful Tips

Here are some useful tips that will help you use this guide effectively.

1. Copy the tutorial files to a location other than the installation folder to make sure you have read/write privileges to the files.
2. Once you start working with the tutorial file, save your work periodically!
3. Don’t stress out too much if you are having trouble with the tutorial. Call us or send us email and we can help you out.
4. Most of all have fun!

1.2 About the MILL Module

The VisualCAM 2018 MILL module offers fast gouge free solids/surface model machining technology coupled with cutting simulation/verification capabilities running inside VisualCAD for programming CNC Mills. This integration allows for seamless generation of toolpath and cut material simulation/verification within VisualCAD, for programming milling machines that support 3, 4 and 5 axis continuous machining.

The module also comes with numerous post-processors to output the programmed G-code to some of the most popular machines on the market. A simple and well thought out user
interface makes this system one of the most intuitive and easy to use milling systems available today.

You can work with the native VisualCAD data as well as use any of the data types that can be imported into VisualCAD such as solids, surfaces and meshes. Then you can use the VisualCAM 2018 MILL module with its wide selection of tools and toolpath strategies to create machining operations and associated toolpaths for CNC Mills. These toolpaths can then be simulated and verified, and finally post-processed to the controller of your choice.

1.3 Using this Guide

If you have installed VisualCADCAM successfully on your computer and are now looking at the blank screen of VisualCAD and wondering what to do next, this is the guide for you. This guide will explain how to get started in using the VisualCAM 2018 MILL module to program a simple part through an example.

This guide will illustrate machining of a simple prismatic part such as this gasket using 2-1/2 Axis milling operations. Even though we have created a 3D representation of the gasket, it will become apparent as we go that we can machine this using just 2D curves. The reason we are able to do this is because of the prismatic nature of this model, which means that the curves can be treated as the edges of vertical walls in the geometry.

This guide has two associated VisualCAD files that you can find located in the QuickStart folder under the installation folder of VisualCAM 2018. The first file is a completed file that contains all of the completed toolpaths and machining operations and represents the file that you should end up with after working through the tutorial. The other file is a starter file that contains only the geometry. Use the completed file as a reference. Copy the starter file and use this file to begin the tutorial.
Getting Ready

2.1 Running VisualCAM 2018

Locate the VisualCADCAM 2018 shortcut on your desktop and double click to launch the application.

Alternatively you can also click on the Windows Start button and select All Programs. Go to the program group containing VisualCADCAM 2018. (The name of this program group will usually be called VisualCADCAM 2018, unless you specified otherwise during setup.)

Once you locate the program group, select it and then select VisualCADCAM 2018 to launch the application.

If the installation was successful, upon launching of VisualCADCAM 2018 you should observe a menu entry called VisualCAM 2018 on the Home Ribbon Bar menu of VisualCAD.

If you do not see this menu entry then please check the On Line Help document of the product (found in the installation folder) for help with trouble shooting the installation.

2.2 About the VisualCAM Display

Before we begin, let’s talk a bit about the VisualCAD display. When you run VisualCAD for the very first time, your screen may look this.

![VisualCAD Display](image)

These windows on the left belong to plug-in modules that are currently loaded. For now, let’s close all of them.
With all plug-in modules closed your screen will look like this:

2.3  Launch the MILL Module

Now, let's begin by launching the VisualCAM 2018 MILL module.

1. From the Plugins pane of VisualCAD’s Home Ribbon Bar, you will see the VisualCAM 2018 main menu item.

2. Drop-down the menu and pick MILL to load the MILL module.
3.Docked on the left you will see the Machining Browser and the Machining Objects Browser. When you first run VisualCAM 2018, these two browsers may be docked side by side. However, you can move them anywhere on the screen that feels comfortable for you.

4. For example, let's move the Machining Objects Browser so that it displays under the Machining Browser on the left. Simply left-click and hold the title bar of the browser and drag it around on your screen.
While doing so, you will see the docking widget display in the background with directional buttons allowing you to choose screen locations relative to the active window.

5. We'll drag the Machining Objects Browser over the base of the Machining Browser until the cursor activates the bottom directional button.

When the preview of the new location displays, let go of the right-mouse button and the browser will move to that location.
6. You can also re-size the height and width of each browser making sure that all of the command icons and menus are easily accessible.
2.4 Load the Part Model

“Part” refers to the geometry that represents the final manufactured product. You can create parts within VisualCAD or import geometry created in another CAD system.

1. From VisualCAD’s Main Menu, select Open.

2. From the Open dialog box, select the MILLQuickStartTutorial.vcp file from the C:\ProgramData\MecSoft Corporation\VisualCAM 2018\QuickStart\ folder. As mentioned before, it is advisable to make a copy of this part at a suitable alternative folder so that you have write privileges to modify the part.
By default, the ProgramData folder is "hidden" from view. Here are the steps to Show hidden files and folders:

1. For Windows7/8 users: Go to Control Panel > Appearance and Personalization > Folder Options. For Windows10 users: Go to Control Panel > Appearance and Personalization > File Explorer Options.

2. Select View tab and under advanced settings select Show Hidden files and folders, clear the check boxes for:
   - Hide extensions for known file types
   - Hide protected operating system files (Recommended)

3. Click Apply and OK.

The part appears as shown below
You can import solid models, Stereo-Lithography (both ASCII and binary) format files. Surfaces and Solids can be imported from IGES, STEP, Rhino (*.3dm), Parasolids (*.x_t, *.X_b), SAT and DXF / DWG files. Faceted (triangulated) models can be imported from STL, VRML, Raw Triangle, or Rhino Mesh.

3. From the View toolbar, select the Isometric View to work in.

2.5 Machining Strategy

Based on the type of geometry of this part, we will machine this model out of a 10 x 6 x 1/8 inch poplar wood sheet. Since the part is relatively thin and prismatic, we will machine this out by using only a single type of machining operation - 2-½ axis machining method called Profiling. We will also use just a single 0.5 inch flat end mill for performing all machining. We will also assume that the wooden sheet will be held to the machine table or the spoil sheet on the table using double-sided tape or a vacuum table requiring no clamps or fixtures.

2.6 Main Programming Steps

The following steps will be followed in machining this model. Some of these steps will have to be performed just once and others may have to be repeated to complete the machining.
1. Define the **Machine** and **Post-processor** to use.
2. Define the **Machining Setup** including **Stock Geometry**, **Material** and **Work Zero**.
3. Create and **Select a Tool** to use for machining.
4. Create the **Machining Operations** including the **Feeds and Speeds**, the **Clearance Plane** and other **Cutting Parameters**.
5. **Generate** the toolpaths.
6. **Simulate** the toolpaths.
7. **Post Process** the toolpaths.
8. **Generate Shop Documentation**.

### 2.7 Define the Machine Tool

Let's start by defining the **Machine** to use for this job.

1. From the **Program** tab select **Machine** to display the dialog box.
2. Under **Machine Type**, set the **Number of Axes** to **3 Axis**.
3. Pick OK and notice that the Machine type now appears under Machining Job in the Machining Browser.

2.8 Select the Post Processor

Next, we'll define the Post Processor.

1. From the Program tab select Post to display the dialog.
2. For the Current Post Processor, select Haas from the list of available posts.
3. Then set the Posted File Extension to .nc. Other file extensions are available depending on your machine requirements.
By default, post processor files are located under:

C:\ProgramData\MecSoft Corporation\VisualCAM 2018\Posts\MILL\n
The program to send the posted output data to is set to notepad.

4. Pick OK and notice that the Post type now appears under Machining Job in the Machining Browser.
The Setup

3.1 Define the Machining Setup - Skip this section if in Standard or Expert Configuration

Now let's define the Machining Setup. The Machining Setup allows you to orient the Machine Coordinate System such that the part is aligned in exactly the same way as it would be fixtured on the machine tool for cutting.

⚠️ This functionality is available only in the Professional and Premium configurations of the product. When working with your part files and running the Express, Standard or Expert configuration, you will have to use the CAD tools to orient the part geometry so that it is in the correct orientation for machining.

If in the future, if there is no Setup1 listed under your Machining Job, the system automatically creates one when a Work Zero or an operation is generated.

However in our tutorial part, by default, the MCS (Machine Coordinate System) is already aligned with the WCS (World Coordinate System) so this step is not required for this part.

However, in production you can have multiple setups and assign different machining orientations for each, when running the Professional or Premium configurations.

3.2 Create Stock Geometry

In this step we'll define the raw stock from which to cut the part.

1. From the Program tab select Stock and then select Box Stock from the menu to display the dialog.
2. Under **Dimensions**, set the **Length L** to 10.0, **Width W** to 6.0 and **Height H** to 0.125. Note that the stock dimensions you enter are measured from the corner of the bounding box selected in this dialog.
The dimensions of the stock are interpreted in relation to the corner selected in the dialog box above. For example if the corner of the box is selected as the Bottom South West corner (as shown in the dialog above), the Length (L) is interpreted to be along the +X axis, the Width (W) along the +Y axis and the Height (H) along the +Z axis.

The direction of the dimensions will change depending on the corner selected. For example if the Top South West corner is selected, then the Height (H) is interpreted to be along the –Z axis and so the stock will extend below the corner.

3. Pick OK and notice that the Stock type now appears under Machining Job in the Machining Browser.
4. If the stock does not display on the screen, select the **Stock Visibility** icon located at the base of the **Machining Browser**.
3.3 Align Part and Stock

Once the stock model is created you can move it in alignment with the part if needed.

1. From the Program tab select Align and then Align Stock from the menu to display the dialog. Notice that we are working our way from left to right in the Program tab.

2. For Z Alignment select Top and for XY Alignment select Center and then pick OK.
The stock is now aligned to the Center of the part in XY and the Top of the part in Z.

**Stock is Aligned**
3.4 Specify Material

Next, we'll set the material for the stock geometry.

1. From the Program tab select Material to display the dialog box.

2. For Material, select Wood from the list of available materials and then pick OK.
3. If the material texture does not display on the stock, select the Material Texture Visibility icon located at the base of the Machining Browser.
3.5 Set Work Zero

Now that the stock is aligned to the part geometry, in this step, we will establish the work coordinate origin also referred to as the Work Zero. The Work Zero translates the MCS origin from the Setup to the desired location. This can be set to any location on the part or stock geometry.

- The Work Zero defines the zero point with respect to which all toolpath points are interpreted by the controller. This would normally be the same as the tool touch off point on the actual work-piece on your machine. So care should be taken to make sure that this Work Zero point defined in

1. From the Program Tab select Align and then Set World CS.
2. Then select **Set to Stock Box**.

3. Then set **Zero Face** to **Highest Z** and **Zero Position** to **South West** corner. This sets the machine home to the top of the stock material and the southwest corner of the stock geometry.

4. Pick **Generate** and the part and stock geometry are now transformed to the **World Coordinate Origin (WCS)**.
Alternatively you can use Work Zero to set the work coordinate origin. Instead of moving the part and stock to the WCS origin, this moves the machine coordinate system origin to the specified location.

1. From the Program Tab select Work Zero to display the dialog.

5. Then select Set to Stock Box.

6. Then set Zero Face to Highest Z and Zero Position to South West corner. This sets the machine home to the top of the stock material and the southwest corner of the stock geometry.
7. Pick Generate and notice that the MCS is translated and that the Work Zero now appears under Setup 1 in the Machining Browser.
Note that the Work Zero should appear as the FIRST item UNDER the Setup in the Machining Job tree so that all operations in that Setup will inherit that Work Zero origin.
Create Tools

To machine the above part we will now create a \( \frac{1}{2} \) inch (0.5") Flat End Mill.

1. Create/Select Tool dialog. Select Flat Mill from the Tool Type menu at the top of the dialog.

2. Set tool Name to FlatMill-0.5 and Tool Diameter to 0.5. Under the Properties tab set Material to HSS and Tool Number to 1.
4. Switch to Feeds and Speeds tab and click **Load from File**.

5. From the dialog that displays, set **Stock Material** to **Wood** and **Tool Material** to **HSS**.
6. Now pick OK and the computed cut feedrate and spindle speed are transferred to the Feeds and Speeds tab of the Create/Select Tool dialog.
7. Pick **Save as New Tool** to save the tool. The tool is now created and listed under **Tools in Session** on the left side of the dialog.

8. Pick **OK** to close the dialog.

You can edit the tool properties and pick **Save Edits to Tool** to save the changes to this tool. To edit and save this as a **New Tool**, you must enter a different tool **Name**.

The created tool is now listed under the **Tools** tab in Machining Objects browser.

In the future you can save your tools to a **Tool Library**. To save **Tools** to a library, click **Save Tool Library** under the **Tools** tab in the Machining Objects Browser and specify a folder location and file name in the **Save as** dialog box. Two **Tool Library** file formats are supported (*.vkb and *.csv). The native **Tool Library** file format for VisualCAM 2018 is *.vkb.
Machine the Inner Profiles

Now we're ready to create our first machining operation.

1. From the Program tab select 2 Axis and then Profiling from the menu of 2 Axis operations.

This will display the 2½ Axis Profiling operations dialog. We will go over the steps for creating the profile operation for the inner features of the Gasket.
5.1 Machining Features/Regions

2. Under the Control Geometry tab pick Select Curve/Edge Regions.

3. Select the first hole by clicking near the upper surface edge as shown below.
4. Repeat to select the edges of the two smaller holes.

Press <Enter> or right-click to end the selection.

5. The 2½ Axis Profiling dialog comes back up displaying the selected Drive Regions. They are also highlighted on the part.

6. Notice that selecting a Drive Region from the list highlights the corresponding surface edge curve on the part.
5.2 Cutting Tool

Now we'll select the Tool for our operation:

1. Switch to the Tool tab of the dialog.

2. Select Flat Mill-0.5 under Tools. The 0.5” Flat End Mill is now selected as the active tool.
Note that the Tool parameters of the currently active tool are always displayed in the status bar at the bottom of the Machining Objects Browser.

5.3 Feeds and Speeds

Now we’ll set the Speeds and Feeds for our operation:

1. Switch to the Feeds & Speeds tab of the dialog.
2. Select the Load from Tool button. VisualCAM 2018 will retrieve the feeds and speeds parameters that were set when the tool was defined and associate them with the current operation.
5.4 Clearance Parameters

Now we'll set the Clearance parameters for our operation:

1. We'll switch to the Clearance Plane tab of the dialog.
2. Set the Clearance Plane Definition to Automatic and Cut Transfer Method to Clearance Plane.
In the **Automatic** mode, **VisualCAM 2018** will determine a safe Z height for locating the clearance plane. Setting the **Cut Transfer Method** to **Clearance Plane** will force all transfer moves to be performed in this determined clearance plane.

When this tab of the dialog is active, the clearance plane is shown on the graphics screen.
5.5 Cut Parameters

Now we'll set the Cut Parameters for our operation:

1. Switch to the Cut Parameters tab of the dialog.

2. Set the Stock to 0. This means that we will not be leaving any thickness on the part after machining.

3. Under the Cut Start Side section check the box next to Use Outside/Inside for Closed Curves and then select Inside.
Alternately you could use the Determine using 3D Model option. In this case VisualCAM 2018 would use the 3D model to determine which side of the curve to place the cutter for machining.

### 5.6 Cut Level Parameters

Now we'll set the Cut Level parameters for our operation:

1. Select the Cut Levels tab of the dialog.
2. Set Location of Cut Geometry to At Top.
3. For Total Cut Depth, enter 0.125. The cut depth is always set as an absolute value.
4. This automatically sets the Rough Depth and Rough Depth/Cut to 0.125.

5.7 Entry/Exit Parameters

Next we'll set Entry and Exit parameters for our operation:

1. Select the Entry/Exit tab of the dialog.
2. Entry/Exit parameters control how the cutter will engage material as it begins cutting and how it leaves the material as it completes cutting.
3. Set Entry Motions and Exit Motions to None.
4. Now pick Generate.
5. The 2½ Axis Profile toolpath is generated and the operation is listed under Setup 1 in the Machining Browser. **NOTE:** Notice that it appears **UNDER** the Work Zero in the Setup.
6. The toolpath is also displayed in the graphics screen.

7. Note that the display of the toolpath in the graphics screen can be turned on/off by selecting the **Toggle Toolpath Visibility** icon located at the base of the **Machining Browser**.
5.8 Cut Material Simulation

The new toolpath can now be Simulated to display the in-process stock model.

1. Switch to the Simulate tab at the top of the Machining Browser.
2. Select Preferences from the Simulate tab.
3. From the Preferences dialog set the Simulation Model to Polygonal and the Simulation Accuracy to Fine and then pick OK.
4. Then from the **Simulate** tab, uncheck **Simulate by Moves** and adjust the slider to the left to slow down the simulation speed.
5. Now, under Setup 1 in the Machining Job tree, select the 2½ Axis Profiling operation we just created and then pick Play to start the simulation.

6. You can stop the simulation at anytime by selecting the Pause button from the Simulate tab. Subsequent to pausing the simulation, you can either choose to continue the simulation by selecting the Play button again or exit the simulation by selecting the Stop button.
7. To view the cut model with textures applied, select the **Toggle Material Texture Visibility** icon located at the base of the **Machining Browser**.
Machine the Outer Profile

Now we will turn our attention to machining the outer profile of the part. Again, we will create a simple profile toolpath, this time around the outer perimeter of the part.

1. Switch to Program tab in the Machining Browser.
2. Select the 2½ Axis Profiling operation we just created.
3. Right-click on the selected operation and select Copy.

4. Now Right-click again and select Paste.
5. This creates a copy of the operation and places it below the original in the Machining Job.
6. Now right-click on the second operation and pick Edit to adjust its parameters.

7. From the Control Geometry tab, pick Remove All.

8. From the Control Geometry tab, pick Select Curve/Edge Regions.

9. Select the top outer surface edge and then right-click or press enter to complete the selection.
10. Switch to the Cut Parameters tab and change the Cut Start Side to Outside.
11. We'll accept all of the remaining parameters and pick Generate.
12. The new 2½ Axis Profiling toolpath is generated and displayed on the graphics screen.
13. Now we'll select the new 2½ Axis Profiling operation we just created, select the Simulation tab and then pick Play.
Post G-Code

Now with the toolpaths complete we're ready to post-process to an output text file containing G-codes that can then be sent to the machine tool to actually machine the part.

1. Select Setup 1 from the Machining Job, right-click and select Post. This will post-process all operations created under the Setup.

2. The Post & Save As dialog is displayed. By default, the Part file name and the Setup name are appended for the G-code File name. Also by default, the posted G-code file is Saved in the folder where the part file is located.

   The output file names can be controlled by setting the Posted File Naming Conventions sections of the Set Post-Processor Options dialog. Refer to the Select the Post Processor step for displaying this dialog.
As you may recall we set the post to Haas back in the Select Post Processor section of this guide. You can change the post processor from this dialog by selecting a different one from the drop down menu in the Current Post list. The posted G-code by default will be saved to the folder where the part file is located.

3. Now pick Post and the G-code file is displayed in Notepad where it can be viewed or edited manually.
Generate Reports

8.1 Information Report

At any time, you can create a Report of your Machining Operations.

1. Switch to Program tab in the Machining Browser.
2. Select Setup 1.
3. Right-click and select Information to display and Print the report.

This dialog provides an estimate of the machining time required for the operations in the Setup.
**Note** *(Professional & Premium configurations only):* In the future, if your Machining Job contains multiple Setups, you can perform the same right-click sequence on the Machining Job to determine the estimated machining time for all Setups.

4. Now pick OK to close the Information dialog.

### 8.2 Shop Documentation

You can also create a **Setup Sheet** by generating a Shop Document. This is typically used to instruct machine operators on how to setup and machine the part on the CNC machine.

1. Under the Machining Job, select Setup1.
2. Right-click and select Shop Documentation.

3. From the Save Shop Documentation File dialog, select Template1 and pick Save.
4. This creates an HTML based Shop Document that can be viewed in a web browser.

You can select from one of the multiple HTML templates that are shipped with the product and generate shop documentation. Each template provides varying amounts of information. Once you have selected the Output Template and pick Save, a shop documentation html file will be created and saved. This file can then be printed and/or viewed in your default web browser such as Internet Explorer.
5. **Note (Professional & Premium configurations only):** In the future, if your Machining Job contains multiple Setups, you can perform the same right-click sequence on the Machining Job to generate Shop Documentation for all Setups.
Where to go for more help

If you need additional help please take advantage of the following MecSoft resources:

1. **On-Line Help**
   The on-line help distributed with the product is a great resource to find reference information on the various functions available.

2. **MecSoft.com**
   Apart from the on-line help system you can download other tutorials and projects from MecSoft Corporation’s web site at [www.mecsoft.com](http://www.mecsoft.com). This will help you get started with using VisualCAM 2018.

3. **Free Videos**
   You can visit the [MecSoft Corporation YouTube Channel](http://www.youtube.com/mecsoft) to watch videos. Note that the functionality of MecSoft’s CAM products is very similar across the different platforms that we support!

4. **MecSoft Blog**
   You can visit the [MecSoft Blog](http://meblog.mecsoft.com) for short articles about using our products.

5. **Case Studies**
   You can also visit our real-world [Case Studies page](http://www.mecsoft.com/casestudies) to learn how others are using MecSoft products in their workshops.

6. **CAMJam Video Archive**
   If you are an active AMS (Annual Maintenance Subscription) user, you have free access to our CAMJam self-training video archive and companion guide containing over 80 videos from our support staff on every aspect of VisualCAM 2018. If you are new or have recently signed up for AMS, this document will show you how to access your CAMJam archive. Want to sign up for AMS? Just give a call at 949-654-8163 (select Option 1 for Sales).

7. **MecSoft Support**
   If you need additional help, or if you have any questions regarding VisualCAM 2018, you may contact us via e-mail at support@mecsoft.com or our [online support page](http://www.mecsoft.com/support).

8. **On-Demand Training**
   MecSoft offers [On-Demand Training](http://www.mecsoft.com/training) as well as personalized full day training sessions. Please look up our website or email us at sales@mecsoft.com for further details.

9. **Product Page**
   Please do continue to [visit the VisualCAM 2018 product page](http://www.mecsoft.com/products) to learn about the latest updates and additional help material.
# Index

## A
- About This Guide 4
- About the MILL Module 4
- Align Part and Stock 23

## C
- Clearance Geometry 42
- Create Machining Operations 37
- Create Stock Geometry 19
- Create Tools 33
- Cut Levels 45

## D
- Define the Machine Tool to use 14
- Define the Machining Setup - Skip this section if in Standard or Expert Configuration 19

## G
- Generating Reports 61
- Getting Ready
  - Machining Strategy 13

## L
- Launching the VisualCAM 2018 MILL Module 7
- Loading the Part Model 11

## M
- Machining Strategy 13
- Machining the Outer Area 53
- Main Programming Steps 13

## P
- Post Processing 58

## R
- Running VisualCAM 2018 6

## S
- Select Cutting Tool 40
- Select Machining Features/Regions 38
- Select the Post Processor to use 15
- Set Feeds and Speeds 41
- Set Work Zero 27
- Simulate Toolpath 49
- Specify Cut Parameters 44
- Specify Material 25

## U
- Useful Tips 4
- Using this Guide and Associated Part Files 5

## W
- Where to go for more help 65